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Introduction 

 
This course has been made for the scaffolding package of SCIA Engineer. In this package the 
following modules are included: 
   

Module Description 

esa.00 1D member modeller 

esa.01 Planar 2D members 

esa.06 Productivity toolbox 

esas.29 Surface load generators 

esas.00 Linear statics 2D 

esas.01 Linear statics 3D 

esas.07 Tension only members 

esas.08 Pressure only support of soil 

esas.09 Nonlinear springs, gaps 

esas.42 Friction springs 

esas.10 Geometrical nonlinear of frames 

esas.13 Stability analysis of frames 

esasd.01.01 Steel code check – EN 1993-1-1 

esasd.13.01 Scaffolding checks - EN 12811-1 

esadt.01 Automated GA drawings 

 
 
If other modules are necessary to perform a specific action described in this manual, it will be 
indicated. 
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Model 

 

General 

The objective of this manual is to show a way of modelling a scaffolding (class 3) using SCIA Engineer. 
In this manual a simple example is elaborated. 

 
 

The following scaffolding will be treated in this course: 
 

 
 
When entering the project, the following project data are chosen: 

 
General XYZ 
Material: S235 
Project level: Advanced 
National Code: EC-EN 

 
 

and the following functionalities: 
 

Non-linearity (+ all options for non linearity on the right hand side) 
Steel - Scaffolding 
Stability 
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Materials 

For the materials, S235 is generally used. However, floor boards and toeboards will be inserted as 
members. The average weight of these toeboards and floor boards differs from the weight of S235. 
That is why it is chosen to insert an extra material in SCIA Engineer, in which the weight will be 
adapted. This weight can be determined as shown below: 
 
 
FLOOR BOARDS 

A distinction is made between floor boards of 19cm and 32cm. For each of them an average weight 
is calculated: 

Name Weight 

[kg] 

Length 

[m] 

[kg/m] Average 

Steel board 
32/307 

23.2 3.07 7.56  

Steel board 
32/257 

19 2.57 7.39  

Steel board 
32/207 

15.7 2.07 7.58  

Steel board 
32/157 

12.2 1.57 7.77 8.20 
kg/m 

Steel board 
32/140 

10.8 1.4 7.71  

Steel board 
32/109 

10.4 1.09 9.54  

Steel board 
32/73 

7.2 0.73 9.86  

Steel board 
19/307 

18.2 3.07 5.93  

Steel board 
19/257 

15.5 2.57 6.03  

Steel board 
19/207 

12.7 2.07 6.14 6.18 
kg/m 

Steel board 
19/157 

10 1.57 6.37  

Steel board 
19/109 

7 1.09 6.42  

 
 
It is assumed that the floor boards have a thickness of 1 cm (instead of 4 cm to reduce the stiffness). 
The weights of the floor boards are: 
 

 Floor boards 0.32m: 𝜌 =
8,2 𝑘𝑔/𝑚

0,32𝑚∙0,04𝑚
 = 640,6 kg/m³ 

  

 Floor boards 0.19m: 𝜌 =
8,2 𝑘𝑔/𝑚

0,19𝑚∙0,04𝑚
 = 1079,0 kg/m³ 
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Cross sections 

Below all cross sections used in the construction are displayed: 
 

 Cross section Material 

 
Standard 

 
RO48.3x3.2 

 
S235 

Ledger RO48.3x3.2 S235 
Guardrail RO48.3x3.2 S235 
Bracing RO48.3x2.3 S235 

Floor board – 0.32m RECT (40; 320) FB 0.32 
Floor board – 0.19m RECT (40; 190) FB 0.19 

Tube RO48.3x3.2 S235 
 

 

 
 

Construction - linear 

The construction will be entered as a 3D Frame for the first level. Afterwards this level is copied 
upward. The type of all members in this frame is entered correctly: 
 

- Columns: column  
- Ledgers: beam  
- Bracings: vertical wind bracing 
- Hinges 
- Supports 
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FLOOR BOARDS 

The input of floor board elements depends on the length of the ledgers. In the picture below all the 
possibilities are displayed. The total length of the ledger is shown at the bottom. The distance of the 
points, on which the floor board has to be entered, is displayed at the top.  
 
 

 
 
 

BRACINGS  

The wind bracings are entered with an eccentricity in the y direction of 48.3 mm (width of the profile): ey 
=+/- 48.3mm. This way the wind bracings are truly on top of the other members and not in between: 
 

 

 

Without eccentricity  With eccentricity 
 

CONNECTIONS 

Standard – Standard connections 

The overlap length between two columns is 200 mm > 150 mm, so the columns are rigid in the x -
direction. 

Moreover, the margin between two columns is 3.9 mm (=48.3 mm – 2 x 3.2 mm – 38 mm), this is 
less than 4 mm. Because of this, also the connection in the y and z direction are rigid. 

According to the code, also the following applies: 
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 According to code EN12811-1, the connection column - column can be considered rigid 
in the modelling 

 A hinge will not be entered at the extremities on the standard 
 
 

Standard – Toeboard and Ledger – Floor board connections 

 
- y direction: Hinged 
- z direction: Rigid 

 

Standard – Bracing connections 

- y direction: Hinged 
- z direction: Rigid 

 

Standard–Ledger and Standard–Guardrail connections 

Or input a certain flexibility in the two directions, for example: 

- y direction:  0,10 MNm/rad 
- z direction: 0,005 MNm/rad 

These rigidities are obtained from data from the supplier. In this case, the rigidity for the y direction is 
taken from the supplier and a smaller value is taken for the z direction. Of course, this is not a 
correct method. Both should be obtained from data from the supplier. 

 

Or choose a “hinge” from our library in SCIA Engineer: 
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And input this hinge on all ledgers and guardrails. 
 
 
 
For those hinges the linear stiffness is input already. The principle about the non linear stiffness will be 
explained later in this course. 
 

 

SUPPORTS 

There are two types of supports: the base jacks at the bottom and the anchorages in the wall.  
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For the base jacks, translations in all directions are fixed (Translations X, Y and Z fixed). For the 
anchorages, only the translations according to the x and y direction are fixed (Translations X and Y 
fixed). 

The anchorages are introduced according to the anchorage scheme: from 4m high, every standard 
has to be anchored every 4 m upward. Over 20 m high, this needs to be performed every 2 m upward. 

 

 

END INPUT OF CONSTRUCTION 

After entering the construction, it is recommended to check the input by using the command “Check 
Structure Data”. Through this function the geometry is checked on errors. 

 
After the check, the option “Connect nodes/edges to members” is applied to the entire construction. 
With this function the different parts are connected to each other. 
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Load cases and combinations 

Load cases 

Type of load cases in EN 12811-1 

There are three main types of loads which need to be considered [EN12811-1, 6.2.1.]: 

a) Permanent loads: these shall include the self weight of the scaffold structure, including all 
components, such as platforms, fences, fans and other protective structures and any ancillary 
structures such as hoist towers. 

b) Variable loads: these shall include service loads (loading on the working area, loads on the side 
protection) and wind loads and, of appropriate, snow and ice loads. 

c) Accidental loads 

 

The permanent loads are inputted as the self weight in SCIA Engineer.  

The only accidental load specified in the European Standard is the downward loading on the side 
protection [more info in EN12811-1, 6.2.5.1]. 

The variable loads can be considered as the service loads and the wind load. 

The service loads are considered in Table 3 of EN 12811-1: 

 

Each working area is capable of supporting the various loadings q1, F1 and F2, separately but not 
cumulatively.  

 

q1: Uniformly distributed service load (EN12811-1, 6.2.2.2) 

Each working area is capable of supporting the uniformly distributed loads, q1 as specified in the 
table above. 

 

F1 and F2: Concentrated load (EN12811-1, 6.2.2.3) 

Each platform unit is capable of supporting the load F1 uniformly distributed over an area of 500mm 
x 500mm and, but not simultaneously, F2 uniformly distributed over an area of 200mm x 200mm. 

The position of each load is chosen to give the most unfavourable effect. 

When a platform unit is less than 500mm wide, the load may be reduced for this unit in proportion to 
its width, except that in no case shall the loading be reduced to less than 1,5kN. 



Advanced Package Training - Scaffolding 

14 

 

q2: Partial area load (EN12811-1, 6.2.2.4) 

This load has to be applied only for classes 4, 5 and 6. In those cases each platform is capable of 
supporting a partial area loading q2 on an area Aq2: 

𝐴𝑞2 = 𝑙 ∙ 𝑤 ∙ 𝑎𝑝  

With: 

l The length 

w The width 

ap Coefficient of Table 3 

  

The dimensions and position of the partial area are chosen to give the most unfavourable effect. One 
example is shown below: 
 

 
 
 
Wind load 
 
Following 6.2.7.4 of EN12811-1, two wind loads have to be calculated: the maximum wind load and the 
working wind load. 
 
 
Maximal wind load 
 
When the European Standard for wind loads is available it is used for the calculation of the maximal 
wind load.  
To make allowance for equipment or materials which are on the working area, a nominal reference 
area is assumed at its level over its full length. This area is 200mm and includes the height of the 
toeboard. (En 12811-1, 6.2.7.4.1) 
 
Note: For the purposes of structural design of façade scaffolds made of prefabricated components, 
design velocity pressures are given in EN 12810-1, 8.3. 
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Working wind load 
 
A uniformly distributed velocity pressure of 0,2 kN/m² is taken into account. 
To make allowance for equipment or materials which are on the working area, a nominal reference 
area is assumed. This area is 400mm and includes the height of the toeboard. (En 12811-1, 6.2.7.4.2) 
 
 
Area of wind loading 
 
The wind load is inputted as an area load. The amount of this load, depends on the amount of the 
loaded area itself, so without cladding a smaller wind load will be inserted than with cladding or netting.  
 
 

Load cases in SCIA Engineer 

The following load cases will be inputted in SCIA Engineer: 

 

Load Case 1: Self Weight 

In this load case the complete self weight of the structure is included, including the toeboards, floor 
board elements, ... 

This load case is automatically calculated by SCIA Engineer. 

 

Load Case 2: Self Weight of the toeboards (and other structural members) 

 
The self weight of the toeboards can be calculated as follows: 
 
Surface area of the profile = 15 cm x 2 cm = 30 cm² = 30 x 10-4 m² 
Density of the toeboard = 773.3 kg/m³  
 
Weight of the toeboard per meter = 30 x 10-4 m² x 773.3 kg/m³ = 2.32 kg/m 
 
Line load: 2.32 x 9.81 N/m = 22,76 N/m = 0,023 kN/m  

 
 

Load Case 3: Service load work condition 

This load case represents the service load that operates over the entire main floor. “Main floor” 
means the most important/crucial floor of the scaffolding. If the load is put on this floor, it leads to the 
most critical values. 

In this example, a class 3 scaffolding has been inserted, so a divided load of 200 kg/m², or 2 kN/m² 
(EN12811-1 Table 3). This is transferred to floor boards.  

Analogous above, also a service load is entered on the complete secondary floor. Secondary floor 
refers to the working area at the first level above or below the main floor. 

According to the code EN12811-1, 50% of the service load has to be put on the secondary floor. 

 

Load Case 4: Service load Max wind 

This load case represents an accumulation of materials and equipments for the complete main 
working area, when the scaffolding is subject to the maximal wind load. 
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Note 

In some cases it can be necessary to input a non symmetric load on the construction. So it can be 
important to input a load case, completely analogous to load case 3, 4 or 5, but here the service load 
is only put on half of the main floor. By executing this load case, the structure is eccentrically loaded, 
so effects that counterbalance each other in a symmetrical load, are revealed here. 

Example: 

 

Full loaded 

 

 

Half loaded 

 

 

Load Case 5: Maximal Wind load Perpendicular to Facade 

Since the arithmetic method for the calculation of a wind load from code EN12811-1 is not valid for 
all scaffoldings, provided by nets that completely surround the construction, the code EN 1991-1-4 is 
adopted. 

There are three cases for calculating a reference height (EN1991-1-4, Figure 7.4) 
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In the example discussed in this course, the height is 11m and the building face is 12,35m. So in this 
case clearly 11m < 12,35m and thus h < b. So the wind only has to be calculated for ze =11m. 

 

In this example, the wind is calculated for a construction without nets, situated in Belgium with a 
terrain category of III.  

The terrain category is determined as follows (EN 1991-1-4, Table 4.1): 

 Terrain category z0 [m] zmin [m] 

0 Sea or coastal area exposed to the open sea 0,003 1 

I Lakes or flat and horizontal area with negligible vegetation and 
without obstacles 

0,01 1 

II Area with low vegetation such as grass and isolated obstacles (trees, 
buildings) with separations of at least 20 obstacle heights 

0,05 2 

III Area with regular cover of vegetation or buildings or with isolated 
obstacles with separations of maximum 20 obstacle heights (such as 

villages, suburban terrain, permanent forest) 

0,3 5 

IV Area in which at least 15% of the surface is covered with buildings 
and their average height exceeds 15m 

1,0 10 

 

For Belgium, vb,0 equals 26.2m/s following the EC-EN. In addition Cdir and Cseason are all equal to 1. 
From this vb can be calculated (EN 1991-1-4 (4.1)): 

vb   = 0,bseasondir vCC 
 
 

= 26,2m/s 

In terrain class III the mean velocity vm are calculated using the following formula (EN 1991-1-4 
(4.3)): 

vm   = bor vzczc  )()(
 

 

where 

co(z) is the orography factor taken as 1,0 (unless specified otherwise in EN 1991-1-4 §4.3.3.) 

and  cr(z) is the roughness factor given by formula  (EN 1991-1-4 (4.4)): 









=

0

ln)(
z

z
kzc rr  

For 
maxmin zzz 

 

( )min)( zczc rr =
 

for 
minzz 
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And  
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The evaluations of these formulas for this example and category III gives: 
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And the mean velocity: 

3,202,261776,0)()( === borm vzczcv m/s 
 

 

Out of these values the peak velocity pressure is calculated by: 

2

2

1
)()()( bebep vzcqzczq ==   

where 

  = 1,25 kg/m³ 

  ( ) ( )2

0

2
)()()(71)( zczczIzc rve +=  











=

0

0 ln)(

)(

z

z
zc

k
zI l

v
 

for 
maxmin zzz 

 

( )min)( zIzI vv =
 

for 
minzz 

 

kl  is the turbulence factor. The recommended value for kl is 1,0. 

These formulas evaluated for this example and category III gives: 
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That way, the total external pressure is obtained by: 

( ) ²/76,0²/760²/2,2625,1
2

1
77,1

2

1
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22 mkNmNmNvzczq bep ====   
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Furthermore, we can assume that the members in the plane perpendicular on the wind load take up 
about 1/5 (=20%) of the total surface of the construction, as shown on the drawing below: 

  

20% of the total pressure is entered on the walls. This equals a total maximal wind pressure of 0.76 
kN/m² x 0.2 = 0.152 kN/m². 

 

 

In this example, the toeboards are already calculated in the “20% of the total surface”: 

In this example the toeboards are 150mm high. The area of EN12811-1; §6.2.7.4.1 is 200mm so it is 
necessary to calculate with an extra height of 50mm (200mm-50mm) due to equipment of the 
working area. 50mm high on a total length of 2m (= 2000mm) corresponds to 2.5% (=50/2000). 

So the wind pressure is: 0.152 kN/m² + (0.025 x 0,76kN/m²) = 0.17 kN/m². 

 

Note 1 

When inputting netting on the structure the following procedure can be taken into account to calculate the 

wind pressure on the structure (Netting = 50%): 

- Calculate the wind force 

- 50% of the wind will be stopped by the netting and carried by the first columns 

- 20% of the other 50% of this wind will be inserted on the first plane 

- 20% of the other 50% of this wind will be inserted on the second plane 

- ... 

Note 2 

In this paragraph the wind has been calculated as a wind pressure. In EN 12810-1a calculation with wind 

forces instead of wind pressures. The difference of this method with the EN 1991-1-4 will be discussed in 

Annex A. 

 
 

Code EN 12811-1 §6.2.7.4.1.: 

To make allowance for equipment or materials which are on the working area, a 
nominal reference area shall be assumed at its level over its full length. This area 
shall be 200 mm high measured from the level of the working area and includes the 
height of the toeboard. The loads resulting from the wind pressure on this area 
shall be assumed to act at the level of the working area. 
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Load Case 6: Maximal Wind load Parallel to Facade 

In an analogous way, the Maximal Wind load is entered parallel to the facade on the structure. 

Also here maximal wind pressures of 0.17kN/m² are entered. 

 

Load Case 7: Working Wind load Perpendicular to Facade 

The code EN12811-1 prescribes that if the scaffolding is into service, it only needs to be loaded with 
the so-called working wind load. 

This working wind load is calculated analogously to the Maximal Wind load on the scaffolding, but a 
reference wind pressure of 0.2 kN/m² is assumed. 

The calculation is done analogous to the maximal wind pressure, only the reference wind pressure of 
0.429 kN/m² (=26,2m/s) from item “Load Case 8” is now replaced by 0.2 kN/m²: 

 
EN 12811-1 §6.2.7.4.2: 
A uniformly distributed velocity pressure of 0,2 kN/m2 shall be taken into account. To make 
allowance for equipment or materials being on the working area, a nominal reference area 
as defined in 6.2.7.4.1, but 400 mm high, shall be used in calculating working wind loads. 

²/354,0²/2,077,1²/2,0)()( mkNmkNmkNzczq ep ===  

The toeboards in this example are 150 mm high. In total an extra height of 250 mm (= 400mm – 
150mm) is calculated with. This corresponds to 12.5% of the total construction (= 250/2000).  

Subsequently, the wind pressure is multiplied by 20% (total surface of the members) and 12.5% (due 
to accumulation of material).  

So the wind pressure is: 0,354 kN/m² x (0.2+0,125) = 0,115 kN/m² 

 

Load Case 8: Working Wind load Parallel to Facade 

In an analogous way, the working wind load is entered parallel to the facade on the structure. In this 
case, the wind pressures are also 0.115 kN/m². 

 

Combinations 

 

Principle of combinations EN 12811-1 

Following EN 12811-1, 6.2.9.2 the load cases have to be combined in two different ways: the service 
condition and the out of service condition 

 
In each individual case the service condition and the out of service condition shall be considered. 
 
a) The service condition consists of:  

 
1) The self weight of the scaffold 

 
2) Uniformly distributed service load (EN 12811-1, Table 3, q1) acting on the working area of 

the most unfavourable decked level 
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3) 50 % of the load specified in a)2) shall be taken to act on the working area at the next level 
above or below if a working scaffold has more than one decked level. 

 
4) Working wind load 

 
 
b) The out of service condition consists of: 

 
1) The self weight of the scaffold 

 
2) A percentage of the uniformly distributed service load (EN 12811-1, Table 3, q1) acting on 

the working area of the most unfavourable decked level. The value depends on the class: 
 

Class 1: 0% (no service load on the working area) 
Classes 2 and 3: 25% (representing some stored materials on the working area) 
Classes 4, 5 and 
6: 

50% (representing some stored materials on the working area) 

 
 

3) The maximum wind load 

 

In cases a)2) and b)2), the load shall be taken as zero, if its consideration leads to more favourable 
results. 

 

Combinations in SCIA Engineer: 

With the principles described earlier in this chapter, the following load cases are made: 

Combination 1: Out of service, Wind perpendicular 

BG1 Self weight 

BG2 Self weight toeboards 

BG4 Service load max wind 

BG5 Maximal wind load perpendicular with facade 

 

Combination 2: Out of service, Wind parallel 

 

BG1 Self weight 

BG2 Self weight toeboards 

BG4 Service load max wind 

BG6 Maximal wind load parallel with facade 

 

Combination 3: Into service, Wind perpendicular 

BG1 Self weight 

BG2 Self weight toeboards 

BG3 Service load in service 

BG7 Working wind load perpendicular with facade 
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Combination 4: Into service, Wind parallel 

 

BG1 Self weight 

BG2 Self weight toeboards 

BG3 Service load in service 

BG8 Working wind load parallel with facade 

 

Coefficients 

With the Combinations in Ultimate Limit State, a safety factor F of 1,50 on the load cases is taken, 

conformable to the code EN 12811 §10.3.2. The safety factor M0 on the material is 1,10. 

For the serviceability F and M shall be taken as 1,00. 

 

 
 
 
And we can change the safety factor for steel in SCIA Engineer in the National Annex: 

Change M0 from 1,00 to 1,10 
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Results 

 

It is recommended to take a look at the reactions first. This way you can check the accuracy of the 
imported loads and load combinations. The calculation protocol (in the result dialog) should be 
reviewed as well.  

The bill of material can also be found in the results menu. In this table the total length for each cross 
section is shown.  

With these results, each user can divide the total length of each type of cross section by the length of 
one member, in order to calculate the total number of ledgers, columns, ... necessary for the 
construction. 

 

 Example  
 

Scaffolding.esa 

 

The results (such as normal force, moment, …) can be viewed per profile type (columns, bracings, 
ledgers). That is why it is recommended to put every cross section in different layers. This way it will 
be easier to review the results per cross section type. 
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Apart from reviewing the results, the anchorage forces have to 
be checked as well. These can be found in “Reactions”: 
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Scaffolding SLS Check – EN 12811-1 

The deformation check in SLS is a part of EC3. According to the code EN1281-11 the allowable 
deformation is L/100. This limit value is set as follows: 

 ‘Steel’ -> ‘Beams’ ->  ‘Steel Setup’ -> ‘Relative deformation’  

 

  

 SLS check in SCIA Engineer 

 

- Choose for ‘SLS Checks - Relative deformation’ in the steel menu and check this for the Class All 
SLS and for the ledgers 

- The maximum check will be found for beam B349: a unity check of 0,24. 

- The values of this check are displayed below.   
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Scaffolding ULS Check – EN 12811-1-1 

 

General 

For a steel check the ULS combinations are used. 

If necessary, the buckling settings of the members have to be checked. 

It is recommended to check Default types of Sway in Steel menu for both directions..  

Further settings about the buckling data can be adapted in the property window of every member, by 
clicking on the three dots behind “System lengths and buckling settings".  

After all the settings have been set right, the check can be performed through ‘Steel’ -> ‘Beams’ -> 
‘ULS Checks’. Also here it is recommended to review the check per profile type. 

This is the regular steel check that is displayed, but for scaffolding a supplementary check will be 
added. This check is performed with the interaction formulae, shown below. 
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According to the Eurocode, the check is only prescribed according to the left hand side table  

“
3

1

,


dplV

V
”. 

If this condition is not met, the construction has to be adapted. However, this is a very heavy check, 
which is why a second column is added in SCIA Engineer, which actually comes from the DIN-code. 
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Scaffolding check in SCIA Engineer 

 

Choose for ‘EC – EN 1993 Steel Check ULS’ in the steel code check (‘ULS Checks’). 

The maximum check will be found for beam B348: a unity check of 0,71. 

 

 

 

SCIA Engineer will show you directly the scaffolding check, when choosing for the Eurocode check 
for circular hollow sections, because we have activated the “Scaffolding” functionality in the 
beginning of the project. If you don’t want to see the scaffolding check, but the general Eurocode 
check (EN 1993-1-1), you can uncheck this option in the Steel Setup: 
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Non-Linear Combinations 

Overview 

Global analysis aims at determining the distribution of the internal forces and moments and the 
corresponding displacements in a structure subjected to a specified loading. 
The first important distinction that can be made between the methods of analysis is the one that 
separates elastic and plastic methods. Plastic analysis is subjected to some restrictions.  
Another important distinction is between the methods, which make allowance for, and those, which 
neglect the effects of the actual, displaced configuration of the structure. They are referred to 
respectively as second-order theory and first-order theory based methods.  
 
The second-order theory can be adopted in all cases, while first-order theory may be used only when 
the displacement effects on the structural behavior are negligible. 
 
The second-order effects are made up of a local or member second-order effects, referred to as the P-

 effect, and a global second-order effect, referred to as the P- effect. 
 

 
 

M(x) = Hx 
M(L) = HL 

First Order Theory 
 

 
 

M(x) = Hx + P  + P x /L 

M(L)= HL + P  
Second Order Theory 

 
 
On the next page an overview of the global analysis following the EN 1993-1-1, chapter 5, will be 
given: 

o All the rules in this overview are given in the EN 1993-1-1 art. 5. For each step the rule will  

be indicated. The first rule (cr > 10) will be explained in EN 1993-1-1 art. 5.2.1(3). 

o In this overview 3 paths are defined: 

▪ Path 1: In this path a first order calculation will be executed 

▪ Path 2: In this path a second order calculation will be executed with global (and 
bow) imperfections. 

▪ Path 3: In this path a second order calculation will be executed with the buckling 
shape of the construction as imperfection. 

o The calculation will become more precise when choosing for a higher path. 

o The lower paths will result in a faster calculation, because a first order calculation can be 
executed without iterations, but this first-order theory may be used only when the 
displacement effects on the structural behavior are negligible. 

o In the next paragraphs the rules in this overview will be explained. 

To take into account all non-linearity’s in the model, non-linear load combinations are made. 

Furthermore, the following applies according to the code EN 12810-2: 
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We can conclude that a second order calculation is always recommended. This second order 
calculation implies to take the local and global imperfections into account, so non-linear 
combinations have to be used. This principle is also shown in the following flow chart of the EN 
12810-2: 

 

Non linear combinations are made as described in the previous chapter. 
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The general procedure for the new EC-EN is shown in the following diagram. 
 

 

5.2.2(3)c 

5.2.2(3)b 

5.2.2(5) 

5.2.2(7)b 

5.3.2(11) 

5.2.2(7)a 

5.2.2(3)a 

5.3.2(6) 

5.2.1(3) 

No Yes 

No Yes 

e0 if 

required 

e0 in all 

members 

Yes No 

cr  10 

 

NEd > 25% Ncr 

(member) 

Members 

with e0 

cr  3 

Increase sway 

effects with: 

cr

1
1

1

−

 

cr 

1b 2b 2c 3 

Global Imperfection  

2a 1a 

1
st
 Order Analysis 2

nd
 Order Analysis 

lb taken equal to L 

Structural Frame Stability 

Section Check 

Stability Check in plane 

Stability Check out of plane + LTB Check 

lb based on a global 

buckling mode 

  With:  cr Elastic critical buckling mode. 
  L Member system length 

  lb Buckling Length 
 

Path 1a specifies the so called Equivalent Column Method. In step 1b and 2a “l_b may be taken 
equal to L”. This is according to EC-EN so the user does not have to calculate the buckling factor =1. 
In further analysis a buckling factor smaller than 1 may be justified. 
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Alpha critical  

The calculation of alpha critical is done by a stability calculation in SCIA Engineer. For this calculation a 
Professional or an Expert edition is necessary. The stability calculation has been inputted in module 
esas.13. 
 
According to the EN 1993-1-1, 1st Order analysis may be used for a structure, if the increase of the 
relevant internal forces or moments or any other change of structural behaviour caused by 
deformations can be neglected. This condition may be assumed to be fulfilled, if the following criterion 
is satisfied: 

 𝛼𝑐𝑟 =
𝐹𝑐𝑟

𝐹𝐸𝑑
≥ 10 for elastic analysis 

 
With:  αcr: the factor by which the design loading has to be increased  

        to cause elastic instability in a global mode. 
    FEd:  the design loading on the structure. 

Fcr: the elastic critical buckling load for global instability,      
          based on initial elastic stiffnesses. 

 
If αcr has a value lower then 10, a 2nd Order calculation needs to be executed. Depending on the type 
of analysis, both Global and Local imperfections need to be considered. 
 
EN1993-1-1 prescribes that 2nd Order effects and imperfections may be accounted for both by the 
global analysis or partially by the global analysis and partially through individual stability checks of 
members. 

 

Global frame imperfection  

The global frame imperfection will be inputted for the whole structure by an imperfection value . This value 

can be calculated with the following formula (EN 1993-1-1 art. 5.3.2(3)a): 

 

 

• 𝜑 =
1

200
∙ 𝛼ℎ ∙ 𝛼𝑚 

• 𝛼ℎ =
2

√ℎ
    but  

2

3
≤ 𝛼ℎ ≤ 1,0 

• 𝛼𝑚 = √0,5 (1 +
1

𝑚
) 

  

With: h The height of the structure in meters 

• m The number of columns in a row including only those columns which carry a 
vertical  

• load NEd not less than 50% of the average value of the vertical load per 
column in  

• the plane considered.  
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These inclination functions are entered through “Main -> Library -> Structure, Analysis -> Initial 
deformations”: 

 

 

The Type is chosen as “According to code”, with a standard imperfection of 1/200.  

The height of the construction is 11m for both inclination functions.  

There are 6 columns in the X-direction, therefore the number of columns in this direction has been 
inputted as “6”. 

There are 2 columns in the Y-direction, therefore the number of columns in this direction has been 
inputted as “2”.  

The inclination function for the x-direction (Def_X) in SCIA Engineer is displayed below: 

 

 

All combinations are entered four times, once with the inclination according to positive x and once 
according to positive y and negative x and negative y: 

  



Advanced Package Training - Scaffolding 

36 

 

Initial bow imperfection e0  

The initial bow imperfection is given by: 
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Where L is the member length. 

 

 

 

 

The buckling curve used for calculation of the imperfection is the curve inputted in the cross-section 
library. For standard sections, the curve according to the code is automatically used, for non-
standard cross sections (as general cross sections) the user needs to input the buckling curve 
manually. 

 
Where L is the member length. 
The bow imperfection has to be applied when the normal force NEd in a member is higher than 25% of 
the member’s critical buckling load Ncr. 

 

SCIA Engineer can calculate the bow imperfection according to the code automatically for all needed 
members. But in a scaffolding structure all profiles have the same buckling curve and thus the same 
bow imperfection. This bow imperfection is inputted as “simple curvature”: the same curvature for all 
members. 
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The second order calculation 

 

Timoshenko 

The first method is the so called Timoshenko method (Th.II.O) which is based on the exact 
Timoshenko solution for members with known normal force. It is a 2nd order theory with equilibrium on 
the deformed structure which assumes small displacements, small rotations and small strains. 
 
When the normal force in a member is smaller than the critical buckling load, this method is very solid. 
The axial force is assumed constant during the deformation. Therefore, the method is applicable when 
the normal forces (or membrane forces) do not alter substantially after the first iteration. This is true 
mainly for frames, buildings, etc. for which the method is the most effective option. 
 
The influence of the normal force on the bending stiffness and the additional moments caused by the 
lateral displacements of the structure (the P-Δ effect) are taken into account in this method.  
 
This principle is illustrated in the following figure. 
 

 
 

M(x) = Hx 
M(L) = HL 

First Order Theory 
 

 
 

M(x) = Hx + P  + P x /L 

M(L)= HL + P  
Second Order Theory 

 
 

The local P- effect will be regarded further in this course. 
 
If the members of the structure are not in contact with subsoil and do not form ribs of shells, the finite 
element mesh of the members must not be refined. 
 
The method needs only two steps, which leads to a great efficiency. In the first step, the axial forces 
are solved. In the second step, the determined axial forces are used for Timoshenko’s exact solution. 
The original solution was generalised in SCIA Engineer to allow taking into account shear 
deformations. 
 
The applied technique is the so called ‘total force method’ or ‘substitution method’. In each iteration 
step, the total stiffness of the structure is adapted and the structure is re-calculated until convergence. 
This technique is illustrated in the following diagram. 
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In this figure, the stiffness K is divided in the elastic stiffness KE and the geometrical stiffness KG. The 
geometrical stiffness reflects the effect of axial forces in beams and slabs. The symbol u depicts the 
displacements and F is the force matrix. 
 
The criterion for convergence is defined as follows: 
 
 

∑(𝑢𝑥,𝑖
2 + 𝑢𝑦,𝑖

2 + 𝑢𝑧,𝑖
2 ) − ∑(𝑢𝑥,𝑖−1

2 + 𝑢𝑦,𝑖−1
2 + 𝑢𝑧,𝑖−1

2 )

∑(𝑢𝑥,𝑖
2 + 𝑢𝑦,𝑖

2 + 𝑢𝑧,𝑖
2 )

≤ 0,005/(𝑝𝑟𝑒𝑐𝑖𝑠𝑖𝑜𝑛 𝑟𝑎𝑡𝑖𝑜) 

 
 
With: ux,i The displacement in direction x for iteration i. 

uy,i The displacement in direction y for iteration i. 
uz,i The displacement in direction z for iteration i. 

 
 
This convergence precision (Precision ratio) can be adapted in the solver setup: 
 

 
Start 

Stop 

Calculate KE 

KG = 0 

K = KE - KG 

Solve K.u = F 

Convergence 

in u? 

Calculate KG 

No 

Yes 
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The choice of the Timoshenko Method and the maximal amount of iterations can be specified through 
Calculation, Mesh > Solver Setup. 
 
 

Newton Raphson 

 
The second method is the so called Newton-Raphson method (Th.III.O) which is based on the 
Newton-Raphson method for the solution of non-linear equations. 
 
This method is a more general applicable method which is very solid for most types of problems. It can 
be used for very large deformations and rotations; however, as specified the limitation of small strains 
is still applicable.  
 
Mathematically, the method is based on a step-by-step augmentation of the load. This incremental 
method is illustrated on the following diagram: 
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In this figure, the tangential stiffness KT is used. The symbol u depicts the displacements and F is the 
force matrix. 
 
The original Newton-Raphson method changes the tangential stiffness in each iteration. There are also 
adapted procedures which keep the stiffness constant in certain zones during for example one 
increment. SCIA ENGINEER uses the original method. 
 
As a limitation, the rotation achieved in one increment should not exceed 5°. 
 
The accuracy of the method can be increased through refinement of the finite element mesh and by 
increasing the number of increments. By default, when the Newton-Raphson method is used, the 
Number of increments is set to 5 and the number of 1D elements is set to 4 in the mesh setup.  
In the Mesh setup we also advise to deactivate the option “Generation of nodes in connections of beam 
elements”. 
 

 
Start 

Stop 

Choose F 

u0 = 0 

F0 = 0 

F = F0 + F 

Determine KT at F0 

Solve KT. u = F 

Convergence 

in u? 

u0 = u 

Determine F0 

No 

Yes 

Any F left? 

u = u0 + u 

No 
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When this option is activated, beams will be connected by the nodes they are going through. But when 
4 nodes are inputted on the beams, it could happen that a node has been inputted in the middle of a 
diagonal and another diagonal is crossing this one in the program and now they are connected. To 
avoid unwanted connections, we advice to uncheck this option. 
 
 
In some cases, a high number of increments may even solve problems that tend to a singular solution 
which is typical for the analysis of post-critical states. However, in most cases, such a state is 
characterized by extreme deformations, which is not interesting for design purposes. 
 
The choice of the Newton-Raphson Method, the amount of increments and the maximal amount of 
iterations can be specified through Calculation, Mesh > Solver Setup. 
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As specified, the Newton-Raphson method can be applied in nearly all cases. It may, however fail in 
the vicinity of inflexion points of the loading diagram. To avoid this, a specific method has been 
implemented in SCIA Engineer: the Modified Newton-Raphson method. 
Also when the Newton-Raphson method is failing, there is the possibility of the method of Picard.  
 
This method follows the same principles as the default method but will automatically refine the number 
of increments when a critical point is reached. This method is used for the Non-Linear Stability 
calculation and will be looked upon in Chapter 7. 
 
 
In general, for a primary calculation the Timoshenko method is used since it provides a quicker solution 
than Newton-Raphson due to the fact Timoshenko does not use increments. When Timoshenko does 
not provide a solution, Newton-Raphson can be applied. 
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Stability 

 

Linear Stability 

 
During a linear stability calculation, the following assumptions are used: 

- Physical Linearity. 

- The elements are taken as ideally straight and have no imperfections. 

- The loads are guided to the mesh nodes, it is thus mandatory to refine the finite element mesh in 
order to obtain precise results. 

- The loading is static. 

- The critical load coefficient is, per mode, the same for the entire structure. 

- Between the mesh nodes, the axial forces and moments are taken as constant. 

 

 
The equilibrium equation can be written as follows: 
 

  FuKK GE =−  

 
The symbol u depicts the displacements and F is the force matrix. 
 
As specified in the theory of the Timoshenko method, the stiffness K is divided in the elastic stiffness 
KE and the geometrical stiffness KG. The geometrical stiffness reflects the effect of axial forces in 
beams and slabs. 
 
The basic assumption is that the elements of the matrix KG are linear functions of the axial forces in the 

members. This means that the matrix KG corresponding to a th multiple of axial forces in the structure 

is the th multiple of the original matrix KG. 
 

The aim of the buckling calculation is to find such a multiple  for which the structure loses stability. 
Such a state happens when the following equation has a non-zero solution: 
 

  0=− uKK GE   

 

In other words, such a value for  should be found for which the determinant of the total stiffness matrix 
is equal to zero: 
 

0=− GE KK   

 
Similar to the natural vibration analysis, the subspace iteration method is used to solve this eigenmode 

problem. As for a dynamic analysis, the result is a series of critical load coefficients  with 
corresponding eigenmodes. 
 
To perform a Stability calculation, the functionality Stability must be activated.  
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In the results menu, the  values can be found under the caption  
The number of critical coefficients to be calculated per stability combination can be specified under 
Setup > Solver. 
 
 
 

Note: 

- The first eigenmode is usually the most important and corresponds to the lowest critical load coefficient. A 

possible collapse of the structure usually happens for this first mode. 

- The structure becomes unstable for the chosen combination when the loading reaches a value equal to the 

current loading multiplied with the critical load factor. 

 

- A critical load factor smaller than 1 signifies that the structure is unstable for the given loading. 

 

- Since the calculation searches for eigen values which are close to zero, the calculated  values can be both 

positive or negative.  

A negative critical load factor signifies a tensile load. The loading must thus be inversed for buckling to occur 

(which can for example be the case with wind loads). 

 

- The eigenmodes (buckling shapes) are dimensionless. Only the relative values of the deformations are of 

importance, the absolute values have no meaning. 

 

- For shell elements the axial force is not considered in one direction only. The shell element can be in 

compression in one direction and simultaneously in tension in the perpendicular direction. Consequently, the 

element tends to buckle in one direction but is being ‘stiffened’ in the other direction. This is the reason for 

significant post-critical bearing capacity of such structures.  

 

- Initial Stress is the only local non-linearity taken into account in a Linear Stability Calculation. 

 

- It is important to keep in mind that a Stability Calculation only examines the theoretical buckling behaviour 

of the structure. It is thus still required to perform a Steel Code Check to take into account Lateral Torsional 

Buckling, Section Checks, Combined Axial Force and Bending,… 
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Manual calculation of KG 

 
The principle of a stability calculation and the meaning of the matrix KG will be explained with a simple 
example:  
 
Suppose the next situation: 

 
 
 
This beam with length L has a pinned support at the left and a flexible spring support at the right with 
rigidity: KE. 
 
Two point loads are inputed on the beam: a vertical  R and a compression force N. 
 
Standard analysis says that R and N are independent (in the un-deformed configuration) and the 
stiffness relationship is: 
 
  𝐾𝐸 ∙ 𝑟 = 𝑅 
 
With r the vertical translation of the right point of the beam.  
 
But, if the structure is allowed to deform, we can calculate equilibrium in the deformed configuration as 
shown below: 
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Summing moments about the pinned end we get: 
 
  𝑅 ∙ 𝐿 + 𝑁 ∙ 𝑟 = 𝑆 ∙ 𝐿 

 
The equation for the response of the spring is:  𝐾𝐸 ∙ 𝑟 = 𝑆 

 
Substituting S we get: 
  
  𝑅 ∙ 𝐿 + 𝑁 ∙ 𝑟 = (𝐾𝐸 ∙ 𝑟) ∙ 𝐿 
 
Dividing by L: 
 

  𝑅 +
𝑁

𝐿
∙ 𝑟 = 𝐾𝐸 ∙ 𝑟 

 
And grouping terms we have: 
  

  𝑅 = (𝐾𝐸 −
𝑁

𝐿
) ∙ 𝑟 

 
 
This can further be re-written if we define the geometric stiffness as: 
 

 𝐾𝐺 =
𝑁

𝐿
 

 
giving the final form as: 
 
  𝑅 = (𝐾𝐸 − 𝐾𝐺) ∙ 𝑟 
 
Of:  [𝐾𝐸 − 𝐾𝐺] ∙ 𝑢 = 𝐹 
 
 

When the normal force N is multiplied with a factor cr so that the total rigidity becomes zero: 
 

𝐾𝐸 −
𝛼𝑐𝑟 ∙ 𝑁

𝐿
= 0 

 
 
The structure will buckle and become “unstable”. 
 

Buckling Shape 

 
As an alternative to Global and Local imperfections, paragraph 13. Non linear combinations allows 
the use of a buckling shape as a unique imperfection. 
 
To input geometrical imperfections, the functionality Nonlinearity > Initial imperfections and Stability 
must be activated. 
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The calculation of the buckling shape through a stability calculation will be looked upon in Chapter 7. 
 

Since the buckling shape is dimensionless, Eurocode gives the formula to calculate the amplitude init 
of the imperfection. In Ref.[13] examples are given to illustrate this method. In this reference, the 
amplitude is given as follows: 
 

cr

cry

cr
init

IE

N
e 


 


=

''

max,

0  

 

( )
( )

( )2
1

2

0

1

1

2,0







−


−

−= M

Rk

Rk

N

M
e   for  2,0  

 

With: 
cr

Rk

N
N

=  

 

   =  The imperfection factor for the relevant buckling curve. 

 =  The reduction factor for the relevant buckling curve, depending on the 
relevant cross-section. 

NRk =  The characteristic resistance to normal force of the critical cross-section, i.e. 
Npl,Rk. 

Ncr =  Elastic critical buckling load. 
MRk =  The characteristic moment resistance of the critical cross-section, i.e. Mel,Rk 

or Mel,Rk as relevant. 

cr =  Shape of the elastic critical buckling mode. 

=''

max,cr Maximal second derivative of the elastic critical buckling mode. 

 

file:///C:/Users/dominique/Documents/SCIA/Trainingen/To%20be%20checked%20(Josipa%20update)/%5bEng%5dAdvanced%20Package%20Training%20Scaffolding%2018.0.docx%23_7._Stability_Calculations


Advanced Package Training - Scaffolding 

50 

 

The value of init can then be entered in the field Max deformation. 
 

  
 
 
 
 

 Example Stability_Imperfection.esa 
 
 
In Chapter 6, the use of the buckling shape as imperfection according to EC3 was discussed. In this 
example, the procedure is illustrated for a column. 
 
The column has a cross-section of type RO48,3x3,2, is fabricated from S235 and has the following 
relevant properties: 
 

E = 210.000 N/mm² fy = 235 N/mm²  M1 = 1.00 
L = 2000 mm  A = 453 mm² 
Iy = 116000mm4  Wpl,y = 6508,8 mm3 
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Calculation of the buckling shape 
 
First a Stability calculation is done using a load of 1kN. This way, the elastic critical buckling load Ncr 
is obtained. In order to obtain precise results, the Number of 1D elements is set to 10. In addition, the 
Shear Force Deformation is neglected so the result can be checked by a manual calculation. 
The stability calculation gives the following result: 
 

  
 
This can be verified with Euler’s formula using the member length as the buckling length: 
 

2

42

2

2

)2000(

116000
²

000.210

mm

mm
mm

N

l

EI
Ncr


==


=60105,89N 

 
 
The following picture shows the mesh nodes of the column and the corresponding buckling shape: 
 
 

  
 
 
 
Using for example an Excel worksheet, the buckling shape can be approximated by a 4th grade 
polynomial. 
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A polynomial has the advantage that the second derivative can easily be calculated. 
 

xExExExEcr

12537410 88,955,770,542,1 −−−− ++−=   

46209''

max, 51,143,370,1 −−− +−= ExExEcr  

 
 
Calculation of e0 

 

=== ²453
²

235 mm
mm

NAfN yRk 106455 N 

=== 38,6508
²

235 mm
mm

NWfM plyRk 1529568 Nmm  

===
N

N
N

N

cr

Rk

60110
106455 1,33 

= 0,21 for buckling curve a 

( ) ( )  ( ) ( ) ( ) ( )2
222

2.015,02.015,0

1





−+−+++−+

= =0,45   

 
 

These intermediate results can be verified through SCIA Engineer when performing a Steel Code 
Check on the column: 
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( )

( )

( )
( )

N

Nmm

N

M
e M

Rk

Rk

106455

1529568
2.033,121,0

1

1

2,0
2

1

2

0 −=
−


−

−=






    

  = 3,41 mm 
 
 
The required parameters have now been calculated so in the final step the amplitude of the 
imperfection can be determined. 
 
 
 

Calculation of init 

The mid section of the column is decisive  x = 1000 
 

 cr at mid section = 636,6 

 

''

max,cr  at mid section = 1,57E-03 
²

1
mm

 

 

6,636

²
11,57E116000

²
210000

60110
41,3

3-4

''

max,

0




=




=

mm
mm

mm
N

N
mm

IE

N
e cr

cry

cr

init 




 

= 3,42 mm 
 
 
This value can now be inputted as amplitude of the buckling shape for imperfection. 
 
 
To illustrate this, the column is loaded by a compression load equal to its buckling resistance.  
 
However, due to the imperfection, an additional moment will occur which will influence the section 
check. The buckling resistance can be calculated as follows: 
 

==


==
²

235²45345,0
1

, mm
Nmm

fA
NN

M

y

RdbEd



47,90 kN 

 
A non-linear combination is created in which the buckling shape as imperfection is specified. 
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Using this combination, a non-linear 2nd Order calculation is executed using Timoshenko’s method. 
 
 
The additional moment can be easily calculated as follows: 
 

kN

kN
mkN

N

N
NM

cr

Ed

initEdinit

11,60

90,47
1

1
00342,090,47

1

1
,

−

=

−

=   

 
           = 0,80 kNm 

 
 
When performing a Steel Code Check on the column for the non-linear combination, this can be 
verified. The critical check is performed at 1m and has the following effects:  
 
 

 
 
The additional moment thus corresponds to the moment calculated by SCIA Engineer. 
 
As seen in the diagram, Path 3 is followed: the buckling shape serves as a unique global and local 
imperfection. This implies that only a section check and Lateral Torsional Buckling need to be checked. 
Since LTB is negligible with this small bending moment, only a section check is required: 
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This example has illustrated the use of a buckling shape as imperfection. Depending on the geometry 
of the structure, this imperfection can have a large influence on the results due to the additional 
moments which occur. 
 
When using this method, it is very important to double check all applied steps: small changes to the 
loading or geometry require a re-calculation of the buckling shape and amplitude before a non-linear 
analysis may be carried out.  
 
As a final note: the buckling shape only gives information about a specific zone of the structure. The 
imperfection is applied at that zone and results/checks are only significant for that zone. Other 
combinations of loads will lead to another buckling shape thus to each load combination a specific 
buckling shape must be assigned and a steel code check should only be used on those members on 
which the imperfection applies. Since the applied buckling shape corresponds to a global mode, failure 
of these members will lead to a collapse of the structure. 
 
 

  



Advanced Package Training - Scaffolding 

56 

Input Hinge Types and non-linear stiffness 

 

Couplers 

General principle 

For connections in a scaffolding structure, a check has to be performed on the normal forces, the 
shear forces and the moments. Various connection types are inserted in SCIA Engineer. For the 
different connections, go to “Libraries -> Structure, Analysis -> Hinge type”. 

  

 

In this “Hinge type library” you can choose following types at the option” Hinge type”:  

 

Right angle coupler Friction sleeve Swivel coupler 
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Base jack Parallel General Right angle continuous 
coupler  

 

 

 

 

 

 

 

 

 

In this connection, not only the rigidities are entered in a flexible or non-linear way, but specifically for these 
connections, the maximal allowable forces can also be inserted, as displayed below for the Right angled 
couplers: 
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The rigidities are filled out and the maximal forces have to be obtained from the info of the connections, 
provided by the supplier. 

 

Manual input 

In this example, a connection of Layher is being adopted (K2000+): 

 

For this connection, it is advisable to enter a general connection containing the properties of Zulassung Z-
8.22-64. For this purpose, the following maximal forces are displayed: 

 

My,R,d = 111 kNcm (=1,11 kNm) 

Mz,R,d = 41 kNcm (=0,41 kNm) 

Vy,R,d = 11 kN 

Vz,R,d = 29,04 kN 

ND,R,d = 34,1 kN 

d [rad] = M/(9140 – 73,6M) 

 

The equation above for the rotation gives the following rotation curve: 
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To enter this correctly, it should be performed using a non-linear spring or a non-linear function in SCIA 
Engineer: 

  

 

If everything is being filled out in the values for this hinge, the following dialog appears: 
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It is assumed that the translations are “rigid” in all directions. Also the rotation around the x-axis is 
considered as “fixed”. This is only a rough estimate. For the rotation around the y-axis, the non-linear 
function (determined earlier) is entered with a linear rigidity of 0,051 MNm/rad. The rotation around the local 
z-axis will be much smaller than around the y-axis namely 0,0051 MNm/rad. 

 

For the values of Vyk, the same value is taken as for Vyz. This value should be determined by the supplier as 
well. 

For the maximal moments the same conclusion can be drawn.  

Subsequently these hinges are attributed to both extremities of the ledgers and guardrails. 

 

Couplers in SCIA Engineer 

 
Some couplers are input already in SCIA Engineer: 

 

Cuplock coupler Layher Variante K2000+ Layher Variante II 
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Layher Variante HS   
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Non linear gaps for bracings 

 
For the connection between the wind bracings and the columns, the rotation around the local y-axis is free. 
There can be a discussion about the rigidity around the z-axis. In this example, it is set on “rigid”, although it 
cannot be completely considered as “rigid”. If you want to enter the exact value, you have to ask the supplier. 
The rotation around the x-axis and the translations in the x, y and z direction are “rigid”. 

 
In the direction of the member (local x direction) there is a certain margin of these wind bracings. This can be 
entered by adopting “Spacings”. For this purpose, all bracings are entered as a “non-linearity” on the 
members, containing the type “Spacing”. 

  

 

Subsequently a margin of 1 mm per member is entered: 
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Non linear supports 

It is also better to enter the supports as non-linear supports. In the vertical direction these supports can only 
take pressure and no tension. This is entered in the z direction with “rigid press only”. The rotations are taken 
free in all directions. 

For the degrees of freedom according to the x and y displacements, the code prEN12812:2003, Annex B is 
applied. In this, the friction coefficients between various materials are entered. If we suppose that the 
scaffolding is placed on wood, we can see in this code that the maximal and minimal frictions coefficient 
between wood and steel is 1.2 and 0.5. On average a value of 0.85 is adopted. This value is also entered in 
SCIA Engineer. 

 

For “C flex” a large value is taken. This corresponds to a large rigidity of the support in the x- and the y- 
direction before the friction is exceeded. 
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Scaffolding Non linear Check 

 
The results of the ULS and SLS check are repeated in this chapter, but now for the non-linear 
combinations and with the correct stiffness for the connections. 
 
 

Relative deformation Check (SLS) 

 

Scaffolding.esa 

- Choose for “Relative deformation” in the steel menu. 

- The maximum check is found for beam B349: a unity check of 0,25. 

The values of this check are displayed below. 
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EC – EN 1993 Steel Check ULS 

 

Choose for “EC – EN 1993 Steel Check ULS” in the steel code check. 

The maximum check is found for beam B347: a unity check of 0,73. 
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Scaffolding – Coupler Check 

 

Checking the internal forces 

When checking the allowable stresses, it is recommended to view the results per profile type 
(standards, bracings, …). The maximal stresses can now be compared to the allowable values of the 
supplier. Also the base jacks are checked with this value. 

For the anchorage forces, the reaction force can be tested to the allowable force of a perpendicular 
coupler. On the other hand, the anchorage can also be checked manually on the combined effect of 
tension and shear. 

For connections this check can be performed by SCIA Engineer itself, with the options “Steel -> 
Scaffolding - Coupler check”. 

 

This check performs a unity check for the couplers for which a maximal allowable force is given in 
the coupler library: 
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Interaction check 

General couplers 

Next to the check on the internal forces, also an interaction check will be executed. For a general 
coupler, the following check will be shown: 

Right angle coupler: 

 
𝑁+𝑉𝑧

2∙
𝐹𝑠𝑘

𝛾𝑀

+
𝑉𝑦

𝐹𝑝𝑘

𝛾𝑀

+
𝑀𝑦

2,4∙(
𝑀𝐵𝑘

𝛾𝑀
)

≤ 1 

  

Friction sleeve: 

 
𝑁

2∙
𝐹𝑠𝑘

𝛾𝑀

+
𝑀𝑦

𝑀𝐵𝑘

𝛾𝑀

≤ 1 

  

With 

 Fsk Characteristic Slipping force 

  Taken as Nxk and Vzk of the coupler properties 

  2 Fsk = Nxk + Vzk 

Fpk Characteristic Pull-apart force 

 Taken as Vyk of the coupler properties 

MBk Characteristic Bending moment 

 Taken as Myk of the coupler properties 

N Normal force 

Vy Shear force in y direction 

Vz Shear force in z direction 

My Bending moment about the y axis 

M Safety factor taken as M0 of EN 1993-1-1 for steel couplers 

 Safety factor taken as M1 of EN 1999-1-1 for aluminium couplers 

 

Manufacturer couplers 

In addition to the scaffolding couplers listed above, specific manufacturer couplers are provided 
within SCIA Engineer.  

The interaction checks of these couplers are executed according to the respective validation reports. 
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Cuplock 

The cuplock coupler which connects a ledger and a standard is described in Zulassung Nr. Z-8.22-
208 

The interaction equations are summarised as follows: 

Interaction 1:  
𝑁

𝑀𝑥𝑘
𝛾𝑀

+
𝑀𝑦

𝑀𝑦𝑘

𝛾𝑀

+
𝑀𝑥

𝑀𝑥𝑘
𝛾𝑀

≤ 1 

 

Interaction 2:  
𝑀𝑦

𝑀𝑦𝑘

𝛾𝑀

+
(𝑁+𝑁𝑣∙𝑠𝑖𝑛(𝛼))

𝑁𝑥𝑘
𝛾𝑀

+
𝑀𝑥

𝑀𝑥𝑘
𝛾𝑀

≤ 1 

 

With 

 Nxk Taken from the coupler properties 

Myk Taken from the coupler properties 

Mxk Taken from the coupler properties 

N Normal force in the ledger 

My Bending moment around the y-axis 

Mx Bending moment around the x-axis 

Nv Normal force in a connecting vertical diagonal 

 Angle between connecting vertical diagonal and standard 

M Safety factor taken as M0 of EN 1993-1-1 for steel couplers 

 Safety factor taken as M1 of EN 1999-1-1 for aluminium couplers 

 

Layher Variante II and K2000+ 

The cuplock coupler which connects a ledger and a standard is described in Zulassung Nr. Z-8.22-64. 
Both Variante II and K2000+ are provided. 
 

Interaction 1:  Variante II: 
𝑁(+)

𝑁𝑅𝑑
+

𝑀𝑦

𝑀𝑦,𝑅,𝑑
+

𝑚𝑎𝑥(𝑉𝑧−1,4  ; 0)

𝑀𝑦
+

𝑉𝑦

25,0
≤ 1 

 

K2000+: 
𝑁(+)

𝑁𝑅𝑑
+

𝑀𝑦

𝑀𝑦,𝑅,𝑑
+

𝑚𝑎𝑥(𝑉𝑧−2,1  ; 0)

𝑀𝑦
+

𝑉𝑦

27,1
+

𝑀𝑇

𝑀𝑇,𝑅,𝑑
≤ 1 
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Variante HS: 
𝑁(+)

𝑁𝑅𝑑
+

|𝑀𝑦|

𝑀𝑦,𝑅,𝑑
+

𝑚𝑎𝑥(|𝑉𝑧|−2,5  ; 0)

𝑉𝑧,𝑅,𝑑
+

|𝑀𝑧|

|𝑀𝑧,𝑅,𝑑|
+

|𝑉𝑦|

|𝑉𝑦,𝑅,𝑑|
+

𝑀𝑇

𝑀𝑇,𝑅,𝑑
≤ 1  

 

Note: An additional check for welds is not supported 

 

Interaction 2:  (𝑛𝐴 + 𝑛𝐵)2 + (𝑣𝐴 + 𝑣𝐵)2 ≤ 1 

   

 

With 

 NR,d = Nxk / M with Nxk taken from the coupler properties 

 MyR,d = Myk / M with Myk taken from the coupler properties 

MzR,d = Mzk / M with Mzk taken from the coupler properties 

 MTR,d = Mxk / M with Mxk taken from the coupler properties 

Vy,R,d = Vyk / M with Vyk taken from the coupler properties 

 Vz,R,d = Vzk / M with Vzk taken from the coupler properties 

N Normal force in the ledger 

(+) indicates a tensile force 

Vy Shear force in y direction 

Vz Shear force in z direction 

My Bending moment around the y-axis 

Mx Bending moment around the x-axis 

Nv Normal force in a connecting vertical diagonal 

 Angle between connecting vertical diagonal and standard 
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e = 2,75 cm for Variante II 

 = 3,30 cm for Variante K2000+ 

= 3,30 cm for Variante HS 

eD = 5,7 cm for Variante II, Variante K2000+ and Variante HS 

    = 1,26 cm for Variante II 

= 1,41 cm for Variante K2000+ 

= 1,15 cm for Variante HS 

M Safety factor taken as M0 of EN 1993-1-1 for steel couplers 

 Safety factor taken as M1 of EN 1999-1-1 for aluminium couplers 

 

Scaffolding.esa 

- Choose for “Scaffolding – Coupler Check” in the steel menu 

- Take a look at the check for beam B347: a unity check of 0,47. 

The values of this check are displayed below. 

 

 

The coupler reaches a value of 0,47 for the interaction check 1, so this means for the following check 
(since we were using K2000+ coupler): 
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𝑁(+)

𝑁𝑅𝑑
+

𝑀𝑦

𝑀𝑦,𝑅,𝑑
+

𝑚𝑎𝑥(𝑉𝑧 − 2,1  ;  0)

𝑀𝑦
+

𝑉𝑦

27,1
+

𝑀𝑇

𝑀𝑇,𝑅,𝑑
≤ 1 
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Aluminium  

 
 
The scaffolding checks of aluminium works exactly the same as for the material steel.  
Also here the checks for Circular Hollow Sections are input in SCIA Engineer and also the coupler 
check has been input in SCIA Engineer for aluminium couplers. 
 
Because everything is also possible in aluminium in SCIA Engineer, you have to indicate in the 
couplers of SCIA Engineer, if they are made out of steel or out of aluminium, because this will change 
the safety factor of the coupler: when choosing for the material aluminium, the safety factor will be 
taken out of the National Annex of EN 1999-1-1 instead of the EN 1993-1-1: 
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Engineering  Report 

 
The scaffolding checks can be add to the Engineering Report: 
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Template 

 
To create a template, the following procedure has to be followed: 
 

1. Create a new project or open an existing one. 
2. Define all the properties and even parts of a structure that should be included in the template. If 

an already existing project is used, make any changes that are necessary. 
3. When you are satisfied with the result and you think that the current state of the project is what 

should become the template, save it As Template using menu function File > Save As. 
4. Browse for the folder where the user templates are stored - this folder is specified in the Setup > 

Options dialogue. 
5. Type the name of the template file. 
6. Complete the action. 

 

With this possibility, it is possible to predefine the cross sections, the (non-linear) combinations, the non 
linear hinges, the document, …  

 

After saving a project as a template, this template can be opened just by making a New Project. 
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User Blocks 

 

The application of user blocks can be divided into three independent steps. The steps must be carried out in 
the given order and all of them must be made. 

1. Creating the user block 

A user block can be created as a standard project. There are no explicit restrictions to it. Usually, 
the user will be working on his/her project and either at the end or some time during the design 
phase s/he decides to make a user block of the current state of the project. 

Then the only thing that must be done is save the project to the disk. It may be useful, however not 
compulsory, to use function Save As and give the project such a name that gives a hint about the 
structure in the project. 

 

2. Storing the user block to the library 

In order to be usable as a user block, the project must be stored in the User block library folder 
(see Program settings > Directory settings). This may be achieved in two ways. 

• The user specifies the proper path in the Save As dialogue (see paragraph above) and 
saves the project directly to the User block library folder. 

• The user saves the project to his/her common project folder and then copies the file to the 
User block library folder. The file may be copied in any file-management tool (e.g. 
Windows Explorer, Total Commander, My Computer dialogue, etc.) 

  
Tip: The user blocks may be stored not only in the given User block library folder, but they may be 
arranged in a tree of subfolders. The subfolders may then group user blocks that have something in 
common. This arrangement may lead to easier and clearer application of user blocks, especially if a 
long time passes from the time they were created and stored. 
 
When using this tip, all the subfolders can be chosen: 

 

 
 

mk:@MSITStore:C:/Program%20Files/SCIA/Engineer2008.1/ESA.chm::/html/Directories_settings.htm
mk:@MSITStore:C:/Program%20Files/SCIA/Engineer2008.1/ESA.chm::/html/Directories_settings.htm
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3. Inserting the user block into another project using the following procedure 

1. Open service Structure: 
a. either by means of tree menu function Structure, 
b. or by means of menu function Tree > Structure, 
c. or by means of icon Structure on toolbar Project. 

2. Select and activate function User blocks. 
3. A User block wizard opens on the screen. Its left hand side window shows the organisation of 

the User block library folder, i.e. it shows any possible subfolders. The right hand side window 
then displays all available user blocks saved in the appropriate folder or subfolder. 

4. Select the required folder. 
5. Select the required User block. 
6. Click [OK] in order to insert the block to the current project. 
7. Select the required options for the import (see below). 
8. Position the user block to the desired place and click the left mouse button to put the block 

there. 
9. If required, repeat the previous step as many times as required or necessary. 

 

  Note: If the User block is a parameterised project, the program asks the user to provide all necessary 
parameters in order to complete the definition of the user block. 
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Attributes  

 
It is possible to add attributes in SCIA Engineer and then make a “bill of material of attributes”. That 
way you will have a perfect overview of the material needed for the calculated scaffold. 
 
You can make attributes under “Tools -> Attributes definition”: 
 
 

 
 
 
First you have to give your first attribute a name, for example “Ledger”. 
The most easy way for scaffolds is using “Combobox”: 
 
 

 
 
 
 
And now you can give the Name and description to the parameter and afterwards all possible “values” 
like the length of the ledgers in this case. And the most common value could be inputted as the Default 
value: 
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This can be repeated for all the cross-section types and then the label setup can be dedefined: 
 

 
 
Now with the “Atrributes” menu the attributes can be inputted on all members, with as value the correct 
length. 
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After inputting the attributes, you can always choose to make them invisible on the screen by the “Set 
view parameters for all” via the tab “Attributes”. 
 
 
And now you can have a list of all attributes in the document via “New -> Special -> Bill of material by 
attributes”: 
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Advanced Package Training - Scaffolding 
 

81 

References 

 

[1] DIN 4420  

Arbeits- und Schutzgerüste 

1990 

 

[2] HD 1000 

Gevelsteigers bestaande uit prefab onderdelen 

1992 

 

[3] EN 12811-1 

Scaffolds: Performance requirements and general design 

2003 

 

[4] EN 12811-3: Scaffolds: Load Testing, 2003 

 

[5] EN 12810-1 

Façade Scaffolds with Prefabricated Components:  

Products specifications 

2003 

 

[6] EN 12810-2 

Façade Scaffolds with Prefabricated Components:  

Particular methods of structural design 

2003 

 

[7] NBN ENV 1991-2-4 

Belasting op draagsystemen: Windbelasting 

1995 

 

[8] Eurocode 3:  

Design of Steel Structures 

2002 

EN 1993-1-1 

 

[9] Handbuch des Gerûstbaus 

Friedrich Nather, Hoachim Lindner, Robert Hertle  

2005 

 

[10] Eurocode 9 

Design of aluminium structures 

Part 1 - 1 : General structural rules  

EN 1999-1-1:2007 

 

[11] Zulassung Z-8.22-64 

 

[12] Modeling – Geometric Stiffness – P -  

 

[13] Höglund T., Beams-Columns, Alternative Imperfection according to Eurocode 9, 2005. 



Advanced Package Training - Scaffolding 

82 

Annex A: Wind pressure versus Wind force 

 
 
In paragraph “6. Load cases” the wind has been calculated with EN1991-1-4 and calculated as a wind 
pressure. 
 
Following EN 12810-1, it is also possible to calculate the wind as a wind force using the following 
formula (EN 12810-1, (1)): 
 

𝐹𝐾 = 𝑐𝑠 ∙ ∑ 𝐴𝑖 ∙ 𝑐𝑓 ∙ 𝑞𝑖

𝑖=𝑛

𝑖=1

 

 
With 
 
Ai  is the reference area specified in EN 12810-1, Table 4 (see also below) 
cf  is the aerodynamic force coefficient taken from EN 12810-1, Table 5 (see also below) 
cs  is the site coefficient taken from EN 12810-1, Table 6 (see also below) 
 
qi  is the design velocity pressure in accordance with EN 12810-1, Figure 3: 
 

 
In this example, the height of the structure is 11m, so qi on 11m is + 940 N/m² and on 0m + 800 N/m². 
When inserting one value a average of those two can be taken: 870 N/m². 
 
 
The reference Area Ai: 
 

Cladding condition of the 
system configuration 

Reference area Ai 

Unclad Area of each component projected in the wind direction 

Clad Surface area of the cladding (see A.3 of En 12811-1:2003) 

 
This example was an unclad example. For a component with a diameter of 48,3mm, the area is  
0,0483m x Lcomponent. 
 
 
The aerodynamic force coefficient cf : 
 

Cladding condition of the 
system configuration 

Force coefficient 

Normal to the façade Parallel to the façade 

Unclad 1,3 1,3 

Clad 1,3 0,1 
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In our example the structure was unclad. We will take a look at the force parallel to the façade, so cf  = 
1,3. 
 
 
The site coefficient cs : 
 

Cladding condition of the 
system configuration 

Site coefficient 

Normal to the façade Parallel to the façade 

Unclad 0,75 1,0 

Clad 1,0 1,0 

NOTE:          The values for the site coefficients correspond to a façade with a solidity ratio B= 0,4; see also EN12811-1. 

 

For an unclad structure, the wind parallel to the façade, results in cs  = 1,0. 
 
 
For each beam the force can be calculated as a line force as shown below: 
 

𝐹𝐾 = 𝑐𝑠 ∙ ∑ 𝐴𝑖 ∙ 𝑐𝑓 ∙ 𝑞𝑖

𝑖=𝑛

𝑖=1

= 1,0 ∙ 0,0483𝑚 ∙ 1,3 ∙
870𝑁

𝑚2
= 54,6

𝑁

𝑚
= 0,055

𝑘𝑁

𝑚
 

 

 
This load is applied on the beams shown below (the toeboards are not taken into account, because the 
force coefficient is only available for tube profiles): 
 
 
 

 

  

 

   

 

So the total force inserted is: 

 

0,055 kN/m x 

       [(2+2x0,5)x 2,57m  

                + (2x0,5)x 2m +3,257]  

= 0,055 kN/m (12,97m) 

= 0,71 kN 

 

  
 
 
In the calculation of “6. Load cases”, a load of 0,17kN/m² has been taken into account. This value 
multiplied with the surface (= 2m x 2,57m) gives a total force of 0,68kN. 
 
So the two option results in a value close to each other. 


	Introduction
	Model
	General
	Materials
	Cross sections
	Construction - linear
	FLOOR BOARDS
	BRACINGS
	CONNECTIONS
	Standard – Standard connections
	Standard – Toeboard and Ledger – Floor board connections
	Standard – Bracing connections
	Standard–Ledger and Standard–Guardrail connections

	SUPPORTS

	END INPUT OF CONSTRUCTION

	Load cases and combinations
	Load cases
	Type of load cases in EN 12811-1
	Load cases in SCIA Engineer
	Load Case 1: Self Weight
	Load Case 2: Self Weight of the toeboards (and other structural members)
	Load Case 3: Service load work condition
	Load Case 4: Service load Max wind
	Load Case 5: Maximal Wind load Perpendicular to Facade
	Load Case 6: Maximal Wind load Parallel to Facade
	Load Case 7: Working Wind load Perpendicular to Facade
	Load Case 8: Working Wind load Parallel to Facade


	Combinations
	Principle of combinations EN 12811-1
	Combinations in SCIA Engineer:
	Combination 1: Out of service, Wind perpendicular
	Combination 2: Out of service, Wind parallel
	Combination 3: Into service, Wind perpendicular
	Combination 4: Into service, Wind parallel

	Coefficients


	Results
	Scaffolding SLS Check – EN 12811-1
	Scaffolding ULS Check – EN 12811-1-1
	General
	Scaffolding check in SCIA Engineer

	Non-Linear Combinations
	Overview
	Alpha critical
	Global frame imperfection (
	Initial bow imperfection e0

	The second order calculation
	Timoshenko
	Newton Raphson

	Stability
	Linear Stability
	Manual calculation of KG
	Buckling Shape

	Input Hinge Types and non-linear stiffness
	Couplers
	General principle
	Manual input
	Couplers in SCIA Engineer

	Non linear gaps for bracings
	Non linear supports

	Scaffolding Non linear Check
	Relative deformation Check (SLS)
	EC – EN 1993 Steel Check ULS

	Scaffolding – Coupler Check
	Checking the internal forces
	Interaction check
	General couplers
	Manufacturer couplers
	Cuplock
	Layher Variante II and K2000+



	Aluminium
	Engineering  Report
	Template
	User Blocks
	Attributes
	References
	Annex A: Wind pressure versus Wind force

